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This tutorial will walk you through all the steps required to make both blended and unique 
textured Atlas terrain, and show you how to load them in TGEA. 

1. Before we start

Required L3DT version

To make Atlas terrain you should be using L3DT version 2.6 or later, as released in October 
of 2008. To check that you have the correct version of L3DT, select the ‘Help→About’ menu 
item. This will show the about box, which includes the version number. 

If you do not have the required version or a later version thereof, please follow the 
instructions below to update your copy of L3DT: 

• If you purchased your licence directly from Bundysoft, please follow the link in your 
purchase receipt e-mail to download the latest release. 

• If you purchased your license from GarageGames, please download the latest version 
of L3DT for Torque from your profile page at GarageGames.com.

Required TGEA version

This tutorial was written for TGEA 1.7.0. If you are using an earlier version of TGEA, the 
methods shown in this tutorial may not work as expected. 

http://www.bundysoft.com/phpBB2/profile.php?mode=viewprofile&u=Aaron
http://www.garagegames.com/


2. Generating your map
This section will briefly describe the terrain generation process, but won’t explain all of the 
settings or the map editing tools and options. If you’d like to know how to get the terrain to 
look exactly how you’d like it, please refer to the other tutorials. I recommend in particular 
the fjord tutorial, as this explains how to use the design map to ‘design’ your terrain map. The 
roads tutorial may also be of interest to users who want to customise their terrain. Finally, if 
you want to know more about any of the windows or settings encountered during this section, 
I recommend you consult L3DT's user guide. 

Anyway, to create your terrain, open L3DT and select ‘File→New project’ in the menu. This 
will open the select terrain algorithm wizard, shown below: 

Select ‘Design/Inflate’ and click ‘next »‘. This will open the heightfield size wizard, shown 
below: 

http://www.bundysoft.com/docs/doku.php?id=l3dt:userguide
http://www.bundysoft.com/wiki/doku.php?id=tutorials:l3dt:roads
http://www.bundysoft.com/wiki/doku.php?id=tutorials:l3dt:fjord
http://www.bundysoft.com/wiki/doku.php?id=tutorials
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Here you may choose the size of your heightfield. For starters I recommend you make a 
512×512 terrain file. 

For FPS-resolution terrain, you must also set the horizontal scale to a small value, such as 1 
(units: metres). This is the horizontal spacing between terrain vertices, and basically sets the 
terrain geometry detail. Small horizontal scale values will give more detailed terrain, but will 
also mean that your map will cover a smaller area. 

Your settings should now look as below: 

If you would like to create terrain larger than 8192×8192, select the split map into tiles 
check-box. This will enable terrain up to 131,072×131,072 pixels. However... [see next note] 
It is not advisable to attempt terrain larger than 4096×4096 with TGEA, as the pre-calculated 
‘chunked LOD’ algorithm used by Atlas is not compatible with very large heightmaps. 

Click ‘next »’ to proceed to the design map size wizard, shown below: 

Here you may choose the resolution of the ‘design map ' that L3DT will use to generate the 
heightfield. For the purposes of this demonstration, I recommend you keep the default value 
of 64 and click ‘next »’ to proceed to the design map parameters wizard, shown below: 
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You may use the default settings here also. Click ‘next »’ to proceed to the calculation queue 
wizard, shown below: 

Enable both the ‘Design map’ and ‘heightfield’ options, and press ‘OK’. L3DT will then 
generate the heightfield for you, and render it in the 2D display: 
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If you wish to view or edit the terrain in 3D, you may do so by pressing the ‘3-D’ button on 
the toolbar. This will open the ‘Sapphire’ 3D renderer for L3DT, which should look 
something like this: 

The instructions for using Sapphire are given here. 

Once you’ve finished your viewing and editing, close Sapphire and select the ‘calc »>’ 
toolbar button in L3DT. This will re-open the calculation queue wizard. In this wizard, 
enable the ‘Water map’ option and every option below it, like so: 

If you intend to make ‘blended’ atlas terrain, you don’t strictly need to generate the texture 
here. However, it may be a good idea still to do so, as it will give you a better idea of what to 
expect in TGEA. 

Click ‘next »’ to proceed to the water map wizard pane. Whilst TGEA does support multiple 
water bodies at different levels using ‘water blocks’, it is rather difficult to set up and get 
right. Thus, it is recommended that you disable the ‘auto flood seas’ and ‘auto flood lakes’ 
options, and instead enable the ‘flood water plane’ options (as shown below). This will create 
one water level for your map. 

http://www.bundysoft.com/wiki/doku.php?id=plugins:sapphire:userguide
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Click ‘next »’ to proceed to the water table wizard, shown below: 

You don’t need to change these settings, so click ‘next »’ to proceed to the attributes map 
wizard (see below). 

http://www.bundysoft.com/wiki/lib/exe/detail.php?id=tutorials:torque:aaron&cache=cache&media=tutorials:torque:aaron:water.png
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The ‘attributes map’ is the mask that L3DT uses to generate textures and alpha maps. Thus, 
to create highly-detailed textures it is recommended that you create a high-resolution 
attributes map. To do this, enable the ‘make high-res attributes map’ option, and set the ‘AM/
HF’ ratio to 4. Also, it is recommended when generating high-resolution maps to enable the 
‘split map into tiles (mosaic map)’ option, as this will reduce the RAM overheads. Your 
settings should look as shown above. 

Click ‘next »’ to proceed to the terrain normals wizard (see below). 

The settings from the previous wizard are carried forwards, so you won’t have to set the map 
resolutions or tile sizes. Your settings should now look as shown above. 

Click ‘next »’ to proceed to the light mapping wizard wizard (see below). 
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You don’t need to change these settings, so click ‘next »’ to proceed to the light mapping (2) 
wizard (see below).

 

Again, the settings are carried forwards. Your settings should now look as shown above. 
Click ‘next »’ to proceed to the Light/water effects wizard (see below). 
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You don’t need to change these settings, so click ‘next »’ to proceed to the texture mapping 
wizard (see below). 

Yet again, the settings are carried forwards, so you don’t need to change them. Your settings 
should look as shown above. 

Click ‘OK’ to generate your map. You will then be shown this message: 

Click OK, and save your map project somewhere (it doesn’t matter where). L3DT will now 
calculate several maps, and when done it will show the texture map in the 2D view: 
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To view the complete terrain in 3D, press the ‘3-D’ button on the toolbar. This will again 
open the Sapphire 3D renderer, which should look something like this: 

The map is now complete, so close Sapphire and press the save button on the toolbar to save 
your project. 
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3. Generating alpha maps
If you intend to create ‘unique textured’ atlas files, you can skip directly to the Exporting to  
TGEA Atlas file section. 

To created blended atlas terrain, you must first generate the alpha maps in L3DT. [Note: 
alpha maps are also known as opacity maps in Atlas.] To generate alpha maps, select the 
‘Operations→Alpha maps→Generate maps’ menu option, shown blow: 

This will open the combine alpha layers wizard, shown below. Stock TGEA 1.7.0 only 
supports 4 alpha layers, but L3DT normally will generate more than this, depending on the 
climates used, the attributes map settings, etc. Thus, we will use this wizard to combine some 
of the alpha layers so that we end up with just four. 

To combine two layers in the alpha wizard, left-click the mouse in the ‘Alpha ID’ entry of 
one of the layers to be combined. This will open a drop-list (shown below), in which you 
should select the alpha ID of the other layer to be combined. 

file:///C:UsersAaronDesktopOff-line atlas tutorialAtlas_tutorial.html#exporting_to_tgea_atlas_file
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Generally it is a good idea to merge together similar layers, such as different kinds of grasses, 
or different kinds of rocks. To help you decide which layers to combine, you can click on the 
‘Texture image’ tab in the right to view the texture of each alpha layer (as shown below). If 
the textures look very similar, then it’s normally a safe bet that you can combine the layers 
without causing the blended atlas terrain to look unnatural. 

You should continue to combine alpha layers until there are only four unique alpha ID 
numbers, as shown above. This means that L3DT will generate four alpha layers, which will 
keep TGEA happy. 

Click ‘Next »’ to proceed to the alpha map options wizard, shown below. 
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In TGEA, the alpha map must be the same size as the light map. This means that you should 
enable the make high-res alpha maps option in this wizard, and set the res. ratio value to the 
same value that you set for the resolution of the light map. If you’ve been following this 
tutorial closely, the correct value should be 4. 

It is also recommended that you enable the ‘split alpha images into tiles’ option. 

When you click ‘OK’, L3DT will generate the alpha maps, and show you something like this: 

If the alpha map looks something like that shown above, then you have done well, and are 
ready to proceed to the atlas export option (discussed next). If, however, you see any black 
areas in the alpha map, it means that you have more than four alpha layers. In this case you 
should go back to the alpha maps wizard and combine some more of the layers. 
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4. Exporting to TGEA Atlas file
Select the menu option at ‘File→Export→to Torque Atlas2 (console plugin)...’ (as below): 

If this is the first time you have used the Atlas2 export option, you will be asked to select the 
TGEA file used to generate the Atlas terrain. Select the file at: 

C:\Torque\TGEA_1_7_0\GameExamples\AtlasDemo\game\AtlasDemo.exe

Next, L3DT will open the ‘Export to TGEA Atlas’ dialog box, shown below: 

The settings in this dialog box are explained below: 

File name

Press the ‘...’ button, then browse to the directory given below, and enter a filename (e.g. 
‘blah.atlas’): 

C:\Torque\TGEA_1_7_0\GameExamples\AtlasDemo\game\scriptsAndAssets\data\terr
ains\

The output atlas file must be in the same directory as the TGEA executable or a subdirectory 
thereof. Otherwise, TGEA won’t be able to ‘see’ the files. 

Export profile

http://www.bundysoft.com/wiki/lib/exe/detail.php?id=tutorials:torque:aaron&cache=cache&media=tutorials:torque:aaron:atlasexportmenu.png
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In the export profile drop-list, select the type of atlas terrain file you want to create: 

• Unique texture — uses the texture map created by L3DT.
• Blended textures — blends the texture using the alpha maps and the light map.

Please note that if you select the ‘blended textures’ option, you must first create the alpha 
maps (see ‘Generating alpha maps’ section.) 

Max. error

The max error value is the maximum allowable error that Atlas will allow when merging 
triangles together in the terrain level-of-detail algorithm. By default, L3DTio_Atlas2 sets the 
maximum height error for Atlas to 1/8th the horizontal resolution of your heightfield. This is 
a reasonable starting point, but in some circumstances you may wish to vary this value: 

• You can decrease the value to archive greater height accuracy. However, this will 
increase the file size, and also increase the triangles shown in TGEA, which may 
degrade FPS. Also, a low max error value on rough terrain will crash TGEA during 
the generation process. If this happens, increase the max error value, and try again.

• You can increase the max error value to reduce the atlas file size, and also the number 
of triangles shown in TGEA, which may potentially improve FPS. This will also 
reduce your chances of TGEA crashing during the atlas file generation process. 

Tree depth

The tree depth value is the depth of the level-of-detail tree that Atlas will use to render the 
terrain. As a general rule, the following values should be used: 

Texture/light map size Tree depth 
1024 2 
2048 3 
4096 4 
8192 5 

Virt. tex. res

For blended textures only. 

This is the resolution of the ‘virtual texture’ map used in TGEA to render the blended terrain. 
Larger values give the impression of more detailed terrain textures, but may also give visible 
feature repeating artefacts. Smaller values will conceal these repeating artefacts, but will give 
more blurry terrain textures. The default value is 8. 

Press OK

When you press OK in the atlas export window, L3DT will export all the map files, and then 
launch TGEA to generate the atlas file. During the generation process you will see the TGEA 
console window, shown below: 

file:///C:UsersAaronDesktopOff-line atlas tutorialAtlas_tutorial.html#generating_alpha_maps


If the build process completes successfully, you will see the message shown below: 

If TGEA crashes, go back to the export window and increase the ‘max error’ value (e.g. to 
0.5m, 1m, 2m, etc.) until TGEA no-longer crashes. 
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5. Loading Atlas terrain in TGEA
Open the ‘simple.mis’ file from the following directory in a text editor: 

C:\Torque\TGEA_1_7_0\GameExamples\AtlasDemo\game\scriptsAndAssets\data\miss
ions\

On the line that says: 

atlasFile = "~/data/terrains/arcticBlended.atlas";

...change it to: 

atlasFile = "~/data/terrains/[whatever your filename was].atlas";
For starters, it is also a good idea to comment-out the water block section from the mission 
file (surround it in ‘/*’ and ‘*/’ block quote markers.) Once you’re satisfied the terrain is OK, 
you can then un-comment the block and tweak the water block position. 

Finally, launch the ‘AtlasDemo.exe’ file in the following directory: 

C:\Torque\TGEA_1_7_0\GameExamples\AtlasDemo\game\

After some loading and initialisation, TGEA should show your terrain, and look something 
like this: 

Atlas unique texture Atlas blended texture 
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6. Troubleshooting
Problems with L3DT
If you have any problems with L3DT, please ask for help in the help and support forum. 

Problems with TGEA
If you have any problems with TGEA, please ask for help in the Bundysoft or GarageGames 
forums. Remember to post the contents of your ‘console.log’ file, which you will find in the 
following directory: 

C:\Torque\TGEA_1_7_0\GameExamples\AtlasDemo\game\
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